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Preface

This documentation is organized under the following headings:

What is Predict Description andGeneration? Restrictions and benefits.Introduction

Contextmenus and commands that are available inNaturalONEwhen
this component has been installed.

Elements of Predict Description
and Generation

How to show the view that is required forworkingwith documentation
objects. Information on preferences and navigation commands.

Getting Started with Predict
Description and Generation

How to display the documentation objects for a specific connection.
How to filter or find the documentation objects, how to display the
properties for the nodes, and how to refresh the tree.

Invoking an Overview of All
Documentation Objects

Howto create documentation objects by redocumentingNatural objects
or by opening the description for a Natural object or library. How to

Managing Natural Objects

find out whether a Natural object or library has already been
documented by displaying its description.

Information on the object type-specific content editors. Information
on the locking mechanism. How to modify, rename or purge
documentation objects.

ManagingDocumentationObjects

How to link/unlink objects, and how tomodify the attributes of a link.Managing Associations and Links

How to generate external objects from documentation objects, and
how to administer external objects (refresh, disconnect and purge).

Managing External Objects

How to simplify continuous integration and deployment, e.g. Adabas
DDMs, files (FDTs) etc. based on Predict definitions.

Managing Predict Components

Notes:

1. Reference documentation is provided separately. See Predefined Object Types in Predict.

2. Certain features concerning external objects (generation and administration) are documented
in External Objects in Predict.

3. This documentation assumes that at least Predict Version 4.6.1 is installed on the server you
are connecting to. If you use an older version of Predict, the contents and design of windows,
tabs and dialogs may differ from those displayed in this documentation.
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Document Conventions

DescriptionConvention

Identifies elements on a screen.Bold

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Monospace font

Identifies:Italic

Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Identifies:Monospace font

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

{ }

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

|

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

[ ]

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

...

Online Information and Support

Software AG Documentation Website

You can find documentation on the Software AG Documentation website at https://documenta-
tion.softwareag.com.

Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to empower@softwareag.comwith
your name, company, and company email address and request an account.

Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.

Predict Description and Generation2
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You can find product information on the Software AG Empower Product Support website at ht-
tps://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.

If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.aspx and give
us a call.

Software AG Tech Community

You can find documentation and other technical information on the SoftwareAGTechCommunity
website at https://techcommunity.softwareag.com. You can:

■ Access product documentation, if you have Tech Community credentials. If you do not, you
will need to register and specify "Documentation" as an area of interest.

■ Access articles, code samples, demos, and tutorials.
■ Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

■ Link to external websites that discuss open standards and web technology.

Data Protection

SoftwareAGproducts provide functionalitywith respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.

3Predict Description and Generation
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New Features

Management of Predict components in NaturalONE
It is nowpossiblemanage Predict components inNaturalONE. SeeManaging Predict Compon-
ents for details.

Predict Description and Generation6
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What is Predict Description and Generation?

Predict Description and Generation is available as an optional component for NaturalONE.

With Predict Description and Generation, you can document Natural sources in Predict via Nat-
uralONE, and you can manipulate and retrieve data stored by Predict on the server. Predict De-
scription and Generation works in the Natural Server Mode.

Note: When you establish a connection to a Natural server environment on a Linux, UNIX
or Windows platform where Predict is installed, you can use the predefined PRFPARM
session parameter.

In addition, you can use Predict Description andGeneration tomanage external objects (generation
and administration).

Restrictions

Some functions are only available in Predict.

In this version of Predict Description and Generation, it is not possible to create new object types.
This is currently only possible with Predict.

In this version of Predict Description and Generation, generation and incorporation is supported
for Adabas and DB2 structures. This includes generation and incorporation of the following:

■ Adabas databases (incorporation only),
■ Adabas files,
■ DB2 databases,
■ DB2 procedures/functions (generation only),
■ DB2 storagegroups,
■ DB2 tablespaces,
■ DB2 tables/views,
■ DDMs for Natural (generation only),
■ activation of automatic processing rules (generation only).

Generation and incorporation of other external objects is currently only possible with Predict.

Predict Description and Generation8
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Benefits

With Predict Description andGeneration, locking of documentation objects takes place. This feature
is not supported in Predict. See Locking of Documentation Objects for further details.

Setting Up a Predict Environment

You install the optional Predict Description and Generation component of NaturalONE using the
Software AG Installer.

If you want to use the optional Predict Description and Generation component of NaturalONE,
Predict Version 8.4.1 or above must be installed on the server and the Natural profile parameter
FDIC on the server must specify a valid Predict file.

You can check this directly from within NaturalONE. To do so, proceed as follows:

1. Map the appropriate Natural server in theNatural Server view (seeMapping a Natural Environ-
ment in Using NaturalONE).

2. Open the properties for the mapped Natural server (see System Information for a Natural Envir-
onment in Using NaturalONE).

3. View the product information (SYSPROD) and the system files (SYSPROF).

When Predict Description and Generation has been installed and when the current context (that
is, the selected item in theNatural Server view) allows it, an additional Predict Description and
Generationmenu is available in the context menu.

9Predict Description and Generation
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When Predict Description and Generation has been installed, additional elements are available in
NaturalONE:

Context Menus

When the current context (that is, the selected item) allows it, the commands described in the
section Commands can be chosen from a Predict Description and Generation context menu.

A context menu also contains further component-specific commands such asOpen, Filter and
Delete. These commands are described later in this documentation.

To invoke a context menu

1 Select the item for which you want to invoke a context menu.

2 Click the right mouse button.

Or:

Press SHIFT+F10.

Or:

Press the menu key on your keyboard.

The context menu appears and you can now choose the required command.

Predict Description and Generation12
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Commands

When Predict Description and Generation has been installed and you have defined a connection
to a server where Predict has been installed, the following commands are available for Natural
objects (displayed in theNatural Server view or in theNavigator view or in a Natural Editor in
NaturalONE):

■ On Natural Server Connections

13Predict Description and Generation
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■ On Natural Objects

On Natural Server Connections

Using this command, you can ...Command

Invoke a tree view window containing all documentation objects.All Objects

Search for specific documentation objects.Find Objects

Invoke the Wizard to generate Schemas into external systems.Schema Generation Wizard

Invoke the Wizard to incorporate Schemas from external systems.Schema Incorporation Wizard

On Natural Objects

Using this command, you can ...Command

Create documentation objects for the selected Natural object. See
Redocumenting Natural Objects for details. This command is not available
for DDMs and Libraries in theNavigator view.

Redocument / Redocument
Objects

Invoke a separatewindow containing a read-only description of the selected
object. SeeManaging Natural Objects for further details.

Display Description

Invoke a separatewindow containing amodifiable description of the selected
object. SeeManaging Natural Objects for further details.

Open Description

Predict Description and Generation14
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Using this command, you can ...Command

Invoke a separate window containing a description of the selected object as
a plain text report. SeeManaging Natural Objects for further details.

Report Description

15Predict Description and Generation
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Setting the Preferences

To set the preferences

1 From theWindowmenu, choose Preferences.

2 In the tree of the resultingwindow, expand theSoftwareAG node and selectPredictDescrip-
tion and Generation.

3 Modify the desired values.

4 Choose theOK button.

Predict Description and Generation18
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Enabling Tracing

You can enable tracing to troubleshoot configuration and connection issues. This option records
what is happening internally within the component.

To enable tracing

1 Activate the Enable tracing check box.

2 Select the desired trace level from the Trace level spin box.

Note: The trace level names, granularity settings and their following description are
taken from the documentation of the org.apache.log4j package (Apache Log4j 1.2.16
API) and are copyright by Apache Software Foundation.

The following trace levels can be set.

DescriptionLevel

The FATAL level designates very severe error events that will presumably lead the application
to abort.

FATAL

The ERROR level designates error events that might still allow the application to continue
running.

ERROR

The WARN level designates potentially harmful situations.WARN

The INFO level designates informationalmessages that highlight the progress of the application
at coarse-grained level.

INFO

The DEBUG level designates fine-grained informational events that are most useful to debug
an application.

DEBUG

The TRACE level designates finer-grained informational events than the DEBUG level.TRACE

Runtime information will now be provided in the standard Eclipse Console view.

To show the Console view

■ From theWindowmenu, choose Show View > Other > General > Console.

The Console view appears.

19Predict Description and Generation
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For information on how to use this view, see the Eclipse documentation.
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Displaying the Documentation Objects for a Specific Connection

To invoke the tree view window containing all documentation objects

■ From the context menu of a server connection in theNatural Server view, choose Predict
Description and Generation > All Objects.

The tree view window appears. It contains the top-level nodeDocumentation Objects.

When you expand theDocumentation Objects node, nodes for all object types (predefined object
types anduser-defined object types) are shown. The object types to be shown can be reduced using
a filter; see Defining the Object Types to be Shown.

When you expand the node for an object type, the defined documentation objects of that type are
shown. You can also apply a filter to an object type, for example, to show only databases of type
Adabas; see Applying a Filter to an Object Type.

When you expand the node for a documentation object, nodes for all active associations of that
object are shown. Some of these nodes can be expanded further.

Predict Description and Generation22
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The following icons are shown for the nodes in the tree:

Top-level node for all documentation objects

Object type

Filtered object type

Documentation object (brown border with light blue content)

Dummy (blue border with blue content)

Placeholder (red)

Link

23Predict Description and Generation
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Filtered link

External Objects

Filtering Documentation Objects

Using a filter, you can reduce the number of items that are shown in the tree. The filter criteria are
saved individually for each user.

The following topics are covered below:

■ Defining the Object Types to be Shown
■ Applying a Filter to an Object Type

Defining the Object Types to be Shown

You can reduce the number of predefined and user-defined object types. For example, you can
define a filter which only shows your own user-defined objects.

To define the object types to be shown

1 In the tree, select the nodeDocumentation Objects.

2 Invoke the context menu and chooseDisplay Filter.

The Select Filter dialog box appears. The object types that are currently shown are selected.
For example:

Predict Description and Generation24
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3 Select the object types that are to be shown, and/or deselect the object types that are not to be
shown. You can use the Select All orDeselect All button to select or deselect all displayed
objects types.

When you select the Turn off filter check box, your filter is not applied. This is useful if you
want to deactivate your filter temporarily.

4 Choose theOK button.

The content of the tree changes. The tree now only shows the object types that you have
defined in your filter.

25Predict Description and Generation
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Applying a Filter to an Object Type

You can reduce the number of objects that are shown for a specific object type. For example, you
can define a filter for the predefined object type Database which only shows the databases of type
Adabas. When a filter has been applied to an object type, the following icon is shown in the tree:

To apply a filter to an object type

1 Select the object type to which you want to apply a filter (for example, the predefined object
type Database).

2 Invoke the context menu and chooseDisplay Filter.

The Filter dialog box appears. The type(s) that are currently shown are listed in the text box
of the Type drop-down list box (only as much as fit in the text box). Example for the object
type Database:

Predict Description and Generation26
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When you select the Turn off filter check box, your filter is not applied. This is useful if you
want to deactivate your filter temporarily.

When you select the Apply filter to links check box, your filter is also applied to links.

3 If you only want to define a filter for a single type, select the type from the Type drop-down
list box.

Or:

If you want to define a filter for more than one type, click the Choose button which is shown
next to the Type drop-down list box.

The Types dialog box appears. The types that are currently shown are selected. Example for
the object type Database:

27Predict Description and Generation
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Select the types that are to be shown, and/or deselect the types that are not to be shown. You
can use the Select All orDeselect All button to select or deselect all types.

Choose theOK button to close the Types dialog box. In the Filter dialog box, the selected
types (as much as fit in the text box) are now shown in the text box of the Type drop-down
list box.

4 If you want to further restrict your filter selection to object types with a specific name, you
can enter the name or the first character(s) of the name followed by an asterisk (*) in theName
text box.

Or:

If youwant to define a filter for more than one name, click theChoose button which is shown
next to theName text box.

TheNames box appears.

Predict Description and Generation28
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Enter the names or the first character(s) of the name(s) followed by an asterisk (*). Choose the
OK button to close theNames dialog box. In the Filter dialog box, the defined names (as
much as fit in the text box) are now shown in theName text box.

5 You can specify further filter criteria on the different tabs of the Filter dialog box. The same
tabs are used in the Find Documentation Objects dialog box. See Finding Documentation
Objects for information on these tabs.

6 When you have defined all filter criteria, choose theOK button to close the Filter dialog box.

When the node for the selected object type is currently open in the tree, you can see that its
contents changes. Only nodes for the types that you have selected are now shown.

29Predict Description and Generation
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Finding Documentation Objects

You can search for objects of a given type. The found objects are shown in a list view window.

To find an object

1 From the Natural Server connection choose Predict Description and Generation > Find Ob-
jects.

Or:

In the Predict Description and Generation view select either the top nodeDocumentation
Objects or a documentation object and from the context menu, choose Find Objects.

The Find Documentation Objects dialog box appears. This dialog box provides several tabs
(some of these tabs are only shown for specific object types):

■ Identification
■ Contents
■ Advanced
■ Object Type Specific

2 Specify your search criteria on the different tabs as described below.

3 Click theOK button.

The Find Documentation Objects dialog box is closed and all found objects are shown in a
list view window. Example:

Predict Description and Generation30
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You canmanage the found objects using the contextmenu. For example, you can open, display
or create a report of an object.

You can print the list view content (or a selection of it) using the standard Eclipse functions:

From the Filemenu choose Print... or click the button.

When no objects meeting the specified search criteria are found, the above window is empty.

31Predict Description and Generation
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Identification

All available object types are provided in a drop-down list box .

Multiple objects can be selected using the Choose button.

When a documentation object was selected before issuing the Find Objects command, the object
type and, if appropriate, type of the selected documentation object are automatically preselected.

Predict Description and Generation32

Invoking an Overview of All Documentation Objects



DescriptionOption

The object type to which the find function applies.Object type

Only available for documentation objects with different types.Type

■ If you only want to find a single type, select the type from the Type drop-down list box.
An asterisk (*) in this drop-down list box means that all types of the selected object type
will be found.

■ If you want to find more than one type, click the Choose button which is shown next to the
Type drop-down list box. The Types dialog box appears. See the example below.

If you know the name of the desired object, enter it in this text box. You can also specify the
first character(s) of the name followed by an asterisk (*) to find all object names that start with
these characters.

If you want to specify more than one name, click the Choose button which is shown next to
theName text box. TheNames dialog box appears. See the example below.

Name

For objects of type Field only. Enter the name of a file. Asterisk notation is possible.Namespace

Example - find more than one object type:

The following dialog box appears.

33Predict Description and Generation
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Example - find more than one type:

The following dialog box appears for object type Program.

Predict Description and Generation34
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The currently defined types are selected. You can now select the required types, or deselect the
types that are not to be considered in your search. Choose theOK button to close the Types dialog
box. On the Identification tab, the selected types (as much as fit in the text box) are now shown
in the text box of the Type drop-down list box.

Example - find more than one name:

The following dialog box appears when click theChoose button next to theName text box. When
names have already been defined, they are shown in the dialog box.

35Predict Description and Generation
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You can enter the names or the first character(s) of the name(s) followed by an asterisk (*). Choose
theOK button to close theNames dialog box. On the Identification tab, the specified names (as
much as fit in the text box) are now shown in the text box of theName text box.

Contents

You can search for objects that contain specific text.

Predict Description and Generation36
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DescriptionOption

Specify the text. The check boxes on this tab are only available when you have entered
text in this text box.

Containing text

If selected, the abstract is searched for the specified text.Abstract

If selected, the extended description is searched for the specified text.Description

If selected, embedded text strings are found (for example, the embedded text string "mari"
in "primarily"). If not selected, only occurrences of the search string that are delimited by
blanks or special characters are found.

Absolute

If selected, rules are to be scanned for the search string. This option applies exclusively
to verifications. With objects of other types, this check box is disabled.

Rules

If selected, objects will only be selected if the specified text occurs in the name (object ID).Name

If selected, no distinction is made between upper-case and lower-case characters.Ignore case

37Predict Description and Generation
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Advanced

You can search, for example, for objects which contain specific keywords or which have a specific
owner.

DescriptionOption

Only objectswith the given keywords are included in the selection.Up to five keywords
can be specified. Asterisk notation is possible.

With

When the option buttonAND is selected, the objectmust contain all specified keywords.
When the option buttonOR is selected, the object must contain one of the specified
keywords.

AND/OR

Objects with the given keyword are excluded. Asterisk notation is possible.But NOT

Only objects with the given owner are included in the selection. Asterisk notation is
possible.

With Owner

Predict Description and Generation38
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DescriptionOption

Only objects contained in the specified extract are included in the selection. With
asterisk notation you can specify a range of extracts.

Included in Extract

Only objects that were added or modified on or after this date will be selected. If a
modification date exists, this will be evaluated. If no modification date exists for an

From Date/Time

object, the creation date is evaluated. Format "MM/DD/YYYY" for the date and "HH:II"
for the time. You can also click on Calendar or use the arrow buttons to specify a
certain date or time.

Only objects that were added or modified on or before this date will be selected. If a
modification date exists, this will be evaluated. If no modification date exists for an

To Date/Time

object, the creation date is evaluated. Format "MM/DD/YYYY" for the date and "HH:II"
for the time. You can also click on Calendar or use the arrow buttons to specify a
certain date or time.

Object Type Specific

The search options on this tab depend on the object type that has been selected on the Identification
tab. This tab does not appear for all object types or if more than one object type is selected. Example
for programs:
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Specify all required search options.

Displaying the Properties

In Predict Description and Generation, the properties for the selected node are automatically
shown in the standard Eclipse Properties view (Show View > Other > General > Properties).

In this view, the contextmenuprovides theCopy command,which can be used to copy the content
of the selected row to the Clipboard.

Different property information is shown, depending on the selected node:

Predict Description and Generation40
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■ Top-level Documentation Objects node
You can see the information that was specifiedwhen the connectionwas created and the version
of Predict which is installed in the remote environment and the FDIC database ID and file
number.

You can see whether a filter is active (Y/N). See also Defining the Object Types to be Shown.

■ Node for an object type
You can see whether a filter exists and whether it is active (Y/N). See also Applying a Filter to
an Object Type.

■ Node for an object of a specific type
You can see when and by whom the object has been added and, if applicable, last modified.
When an abstract has been specified, it is also shown.

41Predict Description and Generation
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■ Node for an association
You can see name, source, destination and direction, and when and by whom the association
was added and, if applicable, lastmodified.When an abstract has been specified, it is also shown.

Refreshing the Tree

You can refresh each node of a connection, so that the latest changes to the documentation objects
are available in the Predict Description and Generation view. When you refresh a node, only the
subtree of this node is refreshed.

Caution: For external objects, a commandwith a similar name,Refresh External, is available.
Do not confuse this commandwith theRefresh command. SeeRefreshing an ExternalObject
for further information.

To refresh the tree

1 Select the node that you want to refresh.

2 Invoke the context menu and choose Refresh.
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Redocumenting Natural Objects

You can create documentation objects for Natural objects that are shown in theNatural Server
view, in theNavigator view or in a Natural Editor.

The following restrictions apply for Natural objects:

■ Currently, it is only possible to redocument Natural sources which reside on the server side.
■ DDMs and Libraries in theNavigator view are not supported.

This feature uses the defaults for the redocument function that have been defined in Predict. The
results of the redocument function are shown in the Predict report view.

The Predict processing option "Add and Replace" is always used. This means: a documentation
object of type Program is created for the selectedNatural object. Or, when a library has been selec-
ted, documentation objects of type Program are created for all Natural objects in this library. Ex-
isting documentation objects are replaced.

It is also possible to create documentation objects in a different way. See the sectionsOpening the
Description for aNaturalObject andAdding aNewDocumentationObject for further information.

To redocument a Natural object

1 Select the Natural object in theNatural Server view or in theNavigator view or in a Natural
Editor.

2 Invoke the context menu and choose Predict Description and Generation > Redocument.

To redocument all Natural objects in a library with a specific type

1 Select the type node (for example subprograms) in theNatural Server view.

2 Invoke the context menu and choose Predict Description and Generation > Redocument
Objects.

To redocument all Natural objects in a library

1 Select the library in theNatural Server view.

2 Invoke the context menu and choose Predict Description and Generation > Redocument
Objects.
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Displaying the Description for a Natural Object

Using theDisplayDescription command, you can display information on a documentation object
for a Natural object, DDM or library.

When a documentation object does not yet exist, awarning appears in the result window indicating
that the object is not documented.

When a documentation object does already exist, an object type-specific window appears and you
can view the defined information. This is the same window which appears when you open the
description for aNatural object, DDMor library (see below). The only difference is that the inform-
ation is provided in read-onlymode and that certain command buttons are therefore not available.

Note: DDMs on platforms running Natural for Windows or UNIX are only supported, if
they reside in library SYSTEMor theNatural systemfile respectively, for DDMs are defined
via the Natural profile parameter FDDM.

To display the description for a Natural object

1 Select the Natural object in theNatural Server view or in theNavigator view or in a Natural
Editor.

2 Invoke the contextmenu and choosePredictDescription andGeneration >DisplayDescrip-
tion.

When a documentation object does already exist, a window for the object type Program ap-
pears. See Program in Predefined Object Types in Predict for further information.

In case of a DDM, a window for the object type File appears. See File in Predefined Object Types
in Predict for further information.

In case of a library, a window for the object type System (system type Application Library)
appears. See System in Predefined Object Types in Predict for further information.

3 Choose theOK button to close the window.
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Opening the Description for a Natural Object

The implementation pointer is used to establish the connection between the Natural object and
the documentation object. In case of a Natural object it consists of member name, library name,
user system file number and user system database number. When you open the description for a
Natural object, the best hit principle is applied: thememberwith themost detailed implementation
pointer is shown. So that a matching documentation object can be found, at least the member
names must match. Exception: in case of a DDM an implementation pointer does not exist; the
connection is established via the name.

In case of a library, the implementation pointer consists of library name, user system file number
and user system database number. So that a matching documentation object can be found, at least
the library names must match.

If no documentation object is found for the selectedNatural object, youwill be askedwhether you
want to redocument the selected object. This dialog is only displayed in theNatural Server view.

When a documentation object can be found, you can modify it.

Note: DDMs on platforms running Natural for Windows or UNIX are only supported, if
they reside in library SYSTEMor theNatural systemfile respectively, for DDMs are defined
via the Natural profile parameter FDDM.

To open the description for a Natural object

1 Select the Natural object in theNatural Server view or in theNavigator view or in a Natural
Editor.

2 Invoke the contextmenu and choosePredictDescription andGeneration >OpenDescription.

Awindow for the object type Program appears. See Program in PredefinedObject Types in Predict
for further information.
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In case of a DDM, a window for the object type File appears. See File in Predefined Object Types
in Predict for further information.

In case of a library, a window for the object type System (system type Application Library)
appears. See System in Predefined Object Types in Predict for further information.

3 Specify all required information. See alsoObject Type-Specific Windows.

4 Choose the Save button to modify the documentation object.

Or:

When you save a new object and a name has not yet been specified, the Save As dialog box
appears. In this case, you have to specify a name for the newdocumentation object and choose
theOK button.

Reporting the Description for a Natural Object

Using theReportDescription command, you can find outwhether a documentation object already
exists for a Natural object, DDM or library.

When a documentation object does not yet exist, awarning appears in the result window indicating
that the object is not documented.

When a documentation object already exists, the Predict Report view appears. The report provides
information on the documentation object in simple text format..

Note: DDMs on platforms running Natural for Windows or UNIX are only supported, if
they reside in library SYSTEMor theNatural systemfile respectively, for DDMs are defined
via the Natural profile parameter FDDM.

To display the description for a Natural object as a report

1 Select the Natural object in theNatural Server view or in theNavigator view or in a Natural
Editor.

2 Invoke the context menu and choose Predict Description and Generation > Report Descrip-
tion.

The report description is displayed.

See also Printing and Saving a Report for a Documentation Object for details.
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Object Type-Specific Content Editors

An object type-specific content editor appears when you open an existing documentation object,
or when you add a new documentation object.

The object type-specific content editors have different tabs with different types of edit controls.

■ Tabs
■ Simple Edit Controls
■ Text Box
■ Text Editor
■ Tables
■ Saving Your Changes

Tabs

Two types of tabs are available:

■ Common tabs that are always the same for all object types areOverview andExtendedDescrip-
tion. See Global Attributes in the reference documentation Predefined Object Types in Predict.

■ Tabs that are only shown for this type of object. See the object type-specific descriptions in the
reference documentation Predefined Object Types in Predict.

The tabs are shown at the bottom of the content editor. When more tabs are available than can be
shown on the screen, a number at the bottom right indicates that there are more tabs. When you
select this number, you can display a tab by choosing its name from a list.

Several tabs require that you specify mandatory information. Such a tab shows an asterisk (*) next
to the tab name.
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Simple Edit Controls

Some tabs provide simple edit controls such as text boxes, check boxes or drop-down list boxes.

For the description of check boxes, the reference documentation Predefined Object Types in Predict
uses the abbreviations Y (yes) and N (no). Y means that the check box is selected, and N means
that the check box is not selected.

Text Box

Some tabs such as theOverview tab provide a simple text editor such as theAbstract section. Edit
commands like Copy and Paste are available in a context menu. Example:
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Text Editor

The following tabs provide a text editor:

■ Extended Description,
■ Processing Rule (of a verification),
■ Check Expression (for files of type DB2 Table),
■ Subquery (for files of type DB2 View) and
■ Field Expression (for a DB2 View Field).

Using the commands from the common Editmenu, you can Cut, Copy, Paste,Delete, Select All
and Find/Replace text. In addition, you can undo and redo your last change and make a Revert
File operation.

The above commands are available using the corresponding Eclipse keyboard shortcuts.

Some of these commands are also available when you invoke the context menu in the editor.

When using the editor the following functions are available:

■ The functionShow line numbers in the EclipsePreferences can be switched on/off in the editor.

To display the Text Editors preferences from within the text editor

1 On any column in the editor, invoke the context menu and click on the Preferences option.

The Text Editors preferences menu is displayed.

2 Activate/deactivate the Show line numbers option.
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3 ClickOK.

The text editor now displays/hides line numbers.

■ The functionGo to line is available via the Eclipse keyboard shortcut Ctrl+L. The following dialog
is displayed:
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■ The Eclipse Status Line shows whether the object is ("Writable" or "Read-Only"), the editor´s
insertmode ("Smart Insert" or "Overwrite") and the current cursor position (following the pattern
"line : column").

A double click on the status field insert mode toggles this mode.

A double click on the status field cursor position opens the above Go to Line dialog.

Tables

Some tabs provide tables to which you can add new information. A tablemay contain one ormore
resizable columns. Example:
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The following command buttons are provided with a table:

DescriptionCommand Button

Creates a new row containing several cells in which you can enter information.Add...

Removes the selected row.Remove

The following functions are provided in the context menu of a table:

DescriptionCommand Button

Creates a new row containing several cells in which you can enter information.Insert

Deletes the selected row.Delete

To modify existing information in a cell of the table, simply overwrite it. You can either enter in-
formation directly in a cell or select it from a drop-down list box.
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Saving Your Changes

To save your changes in an object type-specific content editor, you simply use the Eclipse save
functionality.

Notes:

1. When you save a new object and a name has not yet been specified, the Save As dialog box
appears. In this case, you have to specify a name for the new documentation object and choose
theOK button.

2. When mandatory information has not been specified, an appropriate error message is shown
in a dialog box. The tab onwhich information ismissing is automatically shown. The document-
ation can only be saved after all mandatory information has been specified.

Adding a New Documentation Object

You can manually add documentation objects for all predefined and user-defined objects types
in Predict. You have to specify all information yourself, including the implementation pointer.
This function is helpful, if documentation is to take place before implementation. Information on
the implementation pointer can be found underOpening the Description for a Natural Object.

To add a new documentation object

1 Select the object type for which you want to add a new object.

2 Invoke the context menu and chooseNew.

In some cases, you have to select a type (for example, a database type) in a dialog box. The
resulting content editor then shows object-specific information.

3 Specify all required information as described in the reference documentationPredefinedObject
Types in Predict. See alsoObject Type-Specific Content Editors.

Locking of Documentation Objects

When a documentation object ismodified, renamed or deleted, it is automatically locked to prevent
concurrent updates.

When working with associations and links, the following applies:

■ When the Unlink/Link command is used, the parent object is locked. See also: Linking and
Unlinking Associations.
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■ When theAttributes of Link command is used, both the parent and child object are locked. See
also:Modifying the Attributes of a Link.

Caution: Currently, locking of documentation objects is only possible on the client sidewhen
using Predict Description and Generation. When performing actions on documentation
objects in Predict on the server side, the locking mechanism is ignored. This can result in
inconsistent data.

When a system interruption has occurred, you canmanually unlock locked documentation objects.

Important: You should only unlock a documentation object when you are sure that this object
is currently not being edited by another user.

To unlock a documentation object

1 Select the documentation object that you want to unlock.

2 Invoke the context menu and choose Unlock Object.

Opening/Displaying an Existing Documentation Object

When you open a documentation object, it is possible to modify it (edit mode). There is one excep-
tion: when the documentation object is currently locked, it is only possible to view the information,
it is not possible to modify the documentation object (read-only mode).

To open a documentation object

1 Select the documentation object.

2 Invoke the context menu and choose eitherOpen orDisplay.

Or:

Double-click the documentation object.

An object type-specific content editor appears. See alsoObject Type-Specific Content Editors.
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Renaming a Documentation Object

You can change the object ID with the Rename command. The new object ID must not already
exist in the dictionary.

To rename a documentation object

1 Select the documentation object that you want to rename.

2 Invoke the context menu and choose Rename.

A dialog box appears prompting for a new name.

3 Specify another name and choose theOK button.

Purging a Documentation Object

You can purge documentation objects using the Delete command.

For further information on the purge process, see the object type-specific descriptions in the refer-
ence documentation Predefined Object Types in Predict.

To purge a documentation object

1 Select the documentation object that you want to purge.

2 Invoke the context menu and chooseDelete.

A dialog box appears asking whether you really want to delete the object.

3 To confirm the deletion for the current object, choose theOK button.

Printing and Saving a Report for a Documentation Object

The information shown in an object-type specific window (which can be invoked with theOpen
orDisplay command) can also be shown as a report in simple text format. It is possible to print
and save this report.

To print and save a report

1 Select the documentation object.

2 Invoke the context menu and choose Report.
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A window such as the following appears.

3 Choose the desired command button:

DescriptionCommand Button

The Print Setup dialog box appears. Specify all required information (for example,
a different printer or text orientation) and choose theOK button.

Print

The Save Report dialog box appears. Select the folder in which you want to store the
report, specify a report name and choose the Save button.

Save

4 To close the window in which the report is shown, choose theOK button.
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Linking and Unlinking Objects

You can link more objects to a parent object or remove linked objects. You can also modify the
sequence of the linked objects.

To link and unlink objects

1 Select the node for the desired association in the tree.

2 Invoke the context menu and choose Unlink/Link.

Note: There are several associations for which it is not possible to change the list of
linked objects. The Unlink/Link command is dimmed in these cases. An example of
such an association is "Has Fields"; fields can only be maintained via the object type-
specific content editors which appear for files and fields.

A window appears. The name and type of the parent object and the name of the association
are shown in the title bar. A list of linked objects (children) is shown on the right side of the
window.

3 Use the following command buttons to link/unlink objects:
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DescriptionCommand
Button

Invoke the Find Documentation Objects dialog box in which you can specify the
search criteria for the objects that are to be shown on the left side of thewindow. Found
objects can then be moved to the list of linked objects. For information on the Find
Documentation Objects dialog box, see Finding Documentation Objects.

Find

Move the objects that are currently selected on the left side of the window to the list
of linked objects on the right side of the window. See also the description of the Find
button.

>

Remove the linked objects that are currently selected on the right side of the window.
When a linked object has been removed, it is shown in the list on the left side of the
window.

<

Move all objects from the left side of the window to the list of linked objects on the
right side of the window.

>>

Remove all linked objects on the right side of the window.<<

Add a new object to the list of linked objects. A dialog box appears in which you have
to enter the name for the new object.

New

Move the selected linked object one position up in the list.Up

Move the selected linked object one position down in the list.Down

4 Choose theOK button to saves all changes and to close the window.

Modifying the Attributes of a Link

This function is only available for links where attributes have been defined for the corresponding
association in the metastructure of the Predict data dictionary. With the predefined associations
this is the case, for example, for the links "Has Files" of an Adabas database, and for the links
"Defined in Server" of a DB2 database or file. With user-defined associations, attributes may also
be defined. When such attributes have been defined, it is possible to add or modify their values
for a link.

To modify the attributes of a link

1 Open the node for the desired association in the tree.

2 Select the desired documentation object.

3 Invoke the context menu and choose Attributes of Link.

Adabas databases and files only:
When the logical distribution type "Expanded" or "Partitioned" has been defined, the fol-
lowing Link dialog box appears in which you have to select the link to be modified. A
number in the Phys. file number column stands for the physical file number.
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When the Link dialog box has been invoked using the Unlink/Link command, it is also
possible to add a new link by selectingNew. Choose theOK button to proceed to the as-
sociation-specific content editor (see below).

The tabs that are shown in the resulting content editor depend on the type of association. See
the reference documentation Predefined Object Types in Predict for further information.

The following is an example of an association-specific content editor in which the attributes
of the link can be modified.
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When an object is locked, a corresponding message is shown and the attributes are shown in
read-only mode.

Printing and Saving a Report for the Attributes of a Link

The information shown in an association-specificwindow (which can be invokedwith theAttributes
of Link command) can also be shown as a report in simple text format. It is possible to print and
save this report.

To print and save a report

1 Open the node for the desired association in the tree view window for the documentation
objects.

2 Select the desired documentation object.

3 Invoke the context menu and choose Report Attributes of Link.

A window such as the following appears.
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4 Choose the desired command button:

DescriptionCommand Button

The Print Setup dialog box appears. Specify all required information (for example,
a different printer or text orientation) and choose theOK button.

Print

The Save Report dialog box appears. Select the folder in which you want to store the
report, specify a report name and choose the Save button.

Save

5 To close the window in which the report is shown, choose theOK button.
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Generating an External Object

You can generate an external object from a documentation object.

To generate an external object

1 Select the documentation object for which you want to generate an external object.

You can generate an external object from the following object types:

■ DB2 databases
■ dataspaces
■ files of many different types
■ programs of type database function and SQL procedure
■ storagespaces
■ verifications of type automatic

2 Invoke the context menu and choose Schema Generation Wizard.

The schema generation wizard appears.

3 Specify all required options. If available choose theNext button to proceed to the next page.

For detailed information on the object type-specific information that can be specified using
this wizard, see Generation of External Objects in External Objects in Predict.

4 If all required information has been specified, choose the Finish button to start generation.

When the generation process has completed, the last page of the wizard is shown. When the
List option has been selected on a previous page of the wizard, a report is shown. If an error
occurs during the generation process, an error report is shown.

Incorporating External Objects

This section describes the wizard that is used for schema incorporation.

Thewizard provides several pages inwhich you have to specify information. The number of pages
and the information on these pages depends on the object type that has been selected on the first
page of the wizard.

For detailed information on the object type-specific information that can be specified using this
wizard, see Incorporation in External Objects in Predict.
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The wizard uses edit controls such as text boxes, check boxes or drop-down list boxes. For the
description of check boxes, the reference documentation External Objects in Predict uses the abbre-
viations Y (yes) and N (no). Y means that the check box is selected, and N means that the check
box is not selected.

To incorporate an external schema

1 In theNatural server view, choose Predict Description and Generation > Schema Incorpor-
ation Wizard.

Or:

In thePredictDescription andGeneration view right-click on the root node and selectSchema
Incorporation Wizard

The schema incorporation wizard appears, providing several pages.
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Note: If DB2 is not installed at your site, the incorporation functions for DB2 objects
are not available.

2 Select the option button for the type of external object that you want to incorporate.

3 Choose theNext button to proceed to the next page.

The information on the next pages depends on the object type that has been selected on the
first page.
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Example - incorporate Adabas file:

4 Specify the selection criteria and choose theNext button to proceed to the next page.
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Example - incorporate Adabas file:

The incorporation functions that are available on this page depend on the object type that has
been selected on the first page.

5 From the drop-down list box, select the object that you want to incorporate.

When an object has been selected, the option button(s) for the incorporation function(s) that
can be executed for this object are visible.

For general information on these buttons, see Overview of Incorporation Options in External
Objects in Predict.

6 Select the option button for the incorporation function that you want to execute (Incorporate,
Connect or Test) and choose theNext button to proceed to the next page.
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An additional page appears when you have selected the incorporation function Incorporate
or Connect. You can then specify the incorporation or connect options.

Example - incorporation options for an Adabas file:

Note: Different options or pages appear for the incorporation functions Connect and
Test.

7 Specify the required information and choose theNext button to proceed to the next page.
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Example - incorporate Adabas file:

This page shows only the settings which have been modified on the previous pages.

8 If all required information has been specified, choose the Finish button to start incorporation.

Note: As long as you do not choose the Finish button, you can go back to the previous
pages by choosing the Back button.

When the incorporation process has completed and the List incorporated code option has
been selected previously, a report is shown in a separate Predict Report view. If this option
has not been selected, a message box shows only the resulting message of the incorporation
process.
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However, if an error occurs during the generation process, an error report is shown in the
Predict Report tab. The error report is always shown. The setting of the List incorporated
code option is not considered in this case.
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Example - incorporate Adabas file:

You can Print the report on a printer that is defined in your environment or Save it using the
standard Eclipse functions of the Filemenu .

Refreshing an External Object

You can refresh Adabas files and DB2 tables/views.When you refresh such an external object, you
delete all of its contents.

See Administration of External Objects in External Objects in Predict.

Caution: Do not confuse this type of refresh (this term is usedwith Adabas) with the refresh
function which updates your display see Refreshing the Tree.

To refresh an external object

1 Open the External Objects node containing the external object that you want to refresh.

2 Select the external object.

3 Invoke the context menu and choose Refresh External.

Note: When the refresh function is not available for the selected external object, the
Refresh External command is disabled.

A dialog box appears asking whether you really want to refresh the object.

4 To refresh the current object, choose theOK button.
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Disconnecting an External Object

When you disconnect an external object from its corresponding documentation objects, the imple-
mentation pointer from the documentation object to the external object is deleted, but the object
itself remains intact.

See Administration of External Objects in External Objects in Predict.

To disconnect an external object

1 Open the External Objects node containing the external object that you want to disconnect.

2 Select the external object.

3 Invoke the context menu and chooseDisconnect.

A dialog box appears asking whether you really want to disconnect the object.

4 To disconnect the current object, choose theOK button.

Disconnected external objects are no longer shown in the External Objects node.

Purging an External Object

You can purge external objects using the Delete command. When you purge an external object,
it is disconnected and physically deleted.

See Administration of External Objects in External Objects in Predict.

To purge an external object

1 Open the External Objects node containing the external object that you want to purge.

2 Select the external object.

3 Invoke the context menu and chooseDelete.

A dialog box appears asking whether you really want to delete the object.

4 To confirm the deletion for the current object, choose theOK button.
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Predict Components enable an easy way of distribution and versioning of DB assets (Adabas
DDMs and files (FDTs) based on Predict definitions) for continuous integration and deployment.

How is it used?

Perform the steps as described in:

■ Steps required in Predict
■ Steps required in your Natural Project(s)

Steps required in Predict

To create and manage Predict components

1 In thePredictDescription andGeneration tab expand the File node and eithermodify existing
or create new file(s).

To modify existing file(s) select the file(s) to be modified and right-click on your selection.

To create new file(s) right-click on the File node and from the context menu chooseNew.
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2 Modify or create an extract that contains the artifact that you want to have in your project in
theNavigator view.

To modify existing extract(s) select the extract(s) to be modified and right-click on your selec-
tion.

To create new extract(s) right-click on the Extract node and from the context menu choose
New.

To import objects into the extract(s), choose the Import button.

A standard find dialog appears.

After your selection the import dialog opens from which you can choose the obejcts to be
imported into the extract(s).
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Steps required in your Natural Project(s)

To create and manage Predict components

1 Create new Predict Components folder:

In theNavigator view, right-click on the project folderwhere youwant the Predict Components
folder to be created. In this example, the project is named "Development".

Optional Batch Deploy:

In each Predict Component folder an ant batch file (prf_deploy.xml) and a directory named
pluginswith the *.jar-files for batch deploy is created.

The following commands are available:
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display commandhelp

unloads extracts (uses the *.ULD Files)unload

loads the contents of the extracts (uses the *.PRD Files)load

generates the Predict Objects (e.g. Adabas File) (uses the *.GEN Files)generate

The default name for the Predict Components folder is also "Predict Components". You can
alter the name in the Folder name field.

2 Unload the artifacts from your Predict environment.

In theNavigator view, right-click on the Predict Components folder.

In the context menu click on Predict Components > Unload.

Various files will be created based on your Predict environment to the Predict Components
folder.

Files with a *.GEN suffix contain commands for the Predict Generation.
Files with a *.PRD suffix contain the artifact data for the Predict Load.
Files with a *.ULD suffix contain the names of extracts for the Predict Unload.
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3 Modify and/or adapt the list of files offered in the Unload Predict Componentswizard ac-
cording to your requirements and press Finish.

A successful Unload will result in a UNLOAD TERMINATED SUCCESSFULLYmessage being dis-
played in the Console view.

4 This step is optional.

After unloading all files, add the project to a repository of your choice, e.g. GIT.
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5 Load the Predict data.

In theNavigator view, right-click on the Predict Components folder.

In the context menu click on Predict Components > Load.

Various files will be offered for a Load from your Predict Components folder to the Predict
environment.

6 Modify and/or adapt the list of files offered in theLoad Predict Componentswizard according
to your requirements and press Finish.

A successful Load operation will result in a LOAD TERMINATED SUCCESSFULLYmessage being
displayed in the Console view.

7 In the Predict environment, generate the artifacts from the files loaded in the previous step.

In theNavigator view, right-click on the Predict Components folder.

In the context menu click on Predict Components > Generate.

Ensure that the files with a *.GEN suffix only contain those commands that you want to gen-
erate.

8 Fill in theGenerate Predict Componentswizard and press Finish.

Various artifacts will then be generated in your Predict environment.
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A successful generation will result in a GENERATE TERMINATED SUCCESSFULLYmessage being
displayed in the Console view.
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